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OPERATING INSTRUCTIONS  

BEDIENUNGSANLEITUNG 

MODE D’EMPLOI 

 

EV-128MRS 
MEMORY AUDIO PLAYER  
REPRODUCTOR DE AUDIO CON 
MEMORIA 

 
 
OWNER’S RECORD 
For your convenience, record the model number and the serial 

number (you will find them in the battery compartment of your set) in 

the space provided below. Please refer them when you contact your 

Evoluation dealer in case of difficulty. 
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FCC NOTICE 
 
 

THIS DEVICE COMPLIES WITH PART 15 OF THE FCC FULES. 
OPERATION IS SUBJECT TO THE FOLLOWING TWO CONDITION: 
(1) THIS DEVICE MAY NOT CAUSE HARMFUL INTERFERENCE, AND 
(2) THIS DEVICE MUST ACCEPT ANY INTERFERENCE RECEIVED,  

     INCLUDING INTERFERENCE THAT MAY CAUSE UNDERSIRED  
OPERATION.  

 
 
This equipment has been tested and found to comply with the limits for a Class B 
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses and can radiate radio frequency 
energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communication. However, there is no 
guarantee that interference will not  
occur in a particular installation. If this equipment does cause harmful 
interference to  
radio or television reception, which can be determined by turning the equipment 
off and on, the user is encouraged to try to correct the interference by one or 
more of the following measures :  
 
- Reorient or relocate the receiving antenna.  
 
- Increase the separation between the equipment and receiver.  
 
- Connect the equipment into an outlet on a circuit difference from that to which  
  the receiver is connected.  
 
- Consult the dealer of an experienced radio/TV technician for help.  
 
 
NOTE : The manufacturer is not responsible for any radio or TV interference 
caused by  
unauthorized modifications to this equipment. Such modifications could void the 
user’s  
authority to operate the equipment.  
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NOTICE TO USERS 

WARNING 

TO REDUCE THE RISK OF FIRE OR ELECTRIC SHOCK, DO NOT EXPOSE 

THIS APPLIANCE TO RAIN OR MOISTURE. 

 

Copyright Notices 

Under the copyright laws, neither the documentation nor the software for this 

product may be copied, photocopied, reproduced, translated, or reduced to any 

electronic medium or machine-readable form, in whole or in part, without the prior 

written consent of Evolution Technologies, Inc.. 

 

Copyright © 2002 Evolution Technologies, Inc. All rights reserved. 

 

• Microsoft, Windows, Windows Media and the Windows Logo are trademarks or 

registered trademarks of Microsoft Corporation. 

• Intel and Pentium are registered trademarks of Intel Corporation. 

• MultiMediaCard is a trademark of Infineon Technologies AG. 

• The names of systems and products  appearing in this manual may be 

registered trademarks or trademarks of their respective companies or 

organizations. In this manual, the TM or ® mark is not always explicitly described. 
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Disclaimer 

Evolution Technologies, Inc. will not be responsible for any loss or damage of 

music files due to their transfer to the EV-128MRS player. 

 

About the supplied software 

• For using the supplied Audio Manager software, follow the terms of License 

Agreement that you can view during the installation of the software. 

• You need software upgrades in order to support emerging new compression 

methods other than WMA and MP3. Some software upgrades may not be free of 

charge. 

• For FAQs and downloading the new software for the EV-128MRS player, refer 

to http://www.nowevolution.com 

 

Warning 

You must be aware that distributing copies of WMA- or MP3-format music files to 

any other person without permission is against the copyright laws. You can use 

the software in the supplied installation CD-ROM for personal use only. 

 

COPYRIGHT 

Please check the laws on copyright relating to recordings from discs or external 

tapes for country in which the machine is being used. 
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PRECAUTIONS 

The following are precautions that you should always keep in mind. Any violation 

of one or more of the following precautions may cause damage and will void the 

warranty. 
 

To maintain good performance 

• Avoid exposure to heat, moisture and static electricity. 

• Do not use the player in places that are extremely hot, cold, dusty, or humid. 

• In particular, do not keep the player in a high humidity area such as a bathroom, 

near a heater or in an area exposed to direct sunlight *e.g., inside a parked car). 

• When you carry the battery in your pocket, do not have other metal objects such 

as coins or keys in the same pocket. 

Friction caused by the metal and the battery rubbing together may cause a fire. 

• Make sure that pins or other foreign objects do not get inside the player. 
 

Caution of impact 

Do not drop the player or allow any sharp impact. This may cause serious 

damage to the player. 
 

Note on listening with the headphones 

• Listening to the player at full poser for extended periods of time can result in 

hearing damage. 

• Do not wear the headphones while driving or cycling. This may create a traffic 

hazard. 

• You should use extreme caution or temporarily discontinue use in potentially 

hazardous situations, such as walking, jogging, etc. 

• Wear them properly; L is left and R is right. 

• The in-ear type headphones should be worn with the longer cord behind your 

neck. 
 

To clean the cabinet 
Do not use chemicals to clean the cabinet. This may change the color of the 
player or damage the surface. Use a soft towel to clean the surface of the player.
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Chapter 1. Introduction 

 

� Main features 
• Boosts the capability of portable audio equipment by incorporating the large 

internal memory size in addition to the high audio performance memory audio 

player. 

• Having no drive mechanism results in skip-free sound. 

• The USB computer interface provides high-speed transfer of music files. 

• Plays back highly compressed CD-quality WMA- and MP3-format music files 

that have been transferred from your computer using the supplied Audio Manager 

software. 

 

� Accessories 
The following accessories are supplied with the EV-128MRS player. Make sure 

all of the items are in the package. 

If anything is missing, please contact the store where you purchased the EV-

128MRS player.  
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� System requirements 

The following hardware and software are required for using the supplied Audio 

Manager software. 

 

Hardware requirements 

• Intel Pentium 233 MMX or faster 

• 64MB RAM or more 

• Free hard-disk space 

— 32MB or more for software installation 

— 150MB or more for music-file storage 

• CD-ROM drive that supports digital audio extraction 

• 1 available USB port 

• Sound card 

• 256-color display (16-bit color display is recommended) and 16-bit color video 

card  

• 28.8-kbps modem or faster required for Internet access  

 (ISDN or LAN connection recommended) 

 

Software requirements 

• Microsoft Windows 98 or Windows 98 Second Edition* 

* You can use the Audio Manager software only on computers on which 

Microsoft Windows 98 or Windows 98 Second Edition has been preinstalled by 

the manufacturer.  

The EV-128MRS player does not support Macintosh computers. 

• Microsoft Internet Explorer (Version 4.01 Service Pack 2 or later) 

 

Note 

Sound skip may occur, depending on the configuration of the computer system 

and the applications running on it. 
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� About this manual 
This manual includes basic instructions for using the EV-128MRS player and the 

supplied Audio Manager software. For detailed information on how to use the 

versatile functions provided by Audio Manager, refer to the Help menu that can 

be accessed from the Audio Manager window. 

You are also recommended to read the Readme file included on the installation 

CD-ROM, which contains helpful supplemental information. 

 

� Viewing Help 
To view Help, click “Help” in the Audio Manager window, and then click “Help 

Topics.” 

The “Audio Manager Online Help” window appears. 

 

• Click on  to open any book and display the topics it contains. 

  To close a book, double-click . 

• Click on  to open a topic page. 

• Click an underlined term in the topic to jump to another related topic. 

 

Searching by Keyword 

1. Click the “Index” tab in the Online Help window. 

A list of keywords appears. 

2. Enter the word that you wish to search for or scroll the list of keywords. 

3. Select a keyword from the list and click “Display.” 

The related topic appears. 

When two or more topics are related to a selected keyword, a “Topics Found” 

dialog box appears. Select the desired topic from the list and click “Display.” 
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� Restrictions on transferring music files and using  

  MultiMediaCards 
For the purpose of copyright protection for music files, the EV-128MRS player 

and the supplied Audio Manager software have some restrictions on transferring 

music files and using MultiMediaCards on portable players. 

 

• MP3 files recorded from music CDs can be transferred to up to 3 EV-128MRS 

players. 

• WMA files recorded from music CDs can EV-128MRS players. However, future 

changes in the file format due to changes in specifications or because of 

copyright protection measures may lead to some restrictions on transferring and 

therefore on playing back WMA files on the EV-128MRS player. For detailed 

information, refer to http://www.nowevolution.com. 

• For a music file that is obtained from a content provider via the Internet, the 

number of EV-128MRS players to which you can transfer the music file depends 

on the information written in the file by the content provider. 

• A music file transferred to the player cannot be restored to your computer. 

 

Tip 

For specific restrictions on transferring music files to the EV-128MRS player, click 

on the “Advanced” button, which you can find in the Copy to Devices window. 
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Chapter 2. Preparation 

1. Installing the Audio Manager and driver software 

 

Before using the EV-128MRS player, you must install the Audio Manager and 

driver software on your computer. 

 

Before starting the installation 

• Do NOT connect the EV-128MRS player to your computer. 

• Quit any active applications. 

• If you have already installed a different version of Audio Manager, delete it by 

following the procedure described in “Uninstalling the Audio Manager and driver 

software” (Chapter 2). 

• If you install the Audio Manager software under Windows 98 (but not Windows 

SE), the installation program will not change the program to be associated with a 

WAVE (.wav) file by Audio Manager. If your system is running Windows 98, click 

on “Fix Problem” when the dialog box noticing you for it appears during 

installation. 

 

You can also change the setting after installation is finished. Click on the box to 

the left of “Wave Audio Files” under the “File Types” tag that can be accessed by 

clicking on “Options” of the “View” menu. 

 

1. Insert the installation CD-ROM into the CD-ROM drive of your computer. 

2. Double-click on the My Computer icon on the desktop.  

3. Double-click on the  icon to access the CD-ROM. 
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4. Double-click on the  icon to start the installation program. 
The “Welcome!” dialog box appears. 

 

5. Click on “Next.” 

The “Choose Setup Language” dialog box appears. 

 

6. Select the desired language from the drop-down menu opened by 

clicking on the  button, then click on “OK.” 

The “License Agreement” dialog box appears. 

7. Click on “Yes” if you accept the terms of the Agreement. 

8. Click on “Yes” in the next “Privacy Statement” dialog box if you accept 

the terms of the agreement. 

9. Click on “Next” if you accept the default installation location or click on 

“Browse” to select your desired location from the “Choose Folder” dialog 

box. 

 

Tip 

If you wish to change the configuration, you can click on “Back” to redo any step 

of the installation process. 
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10. Click on “Next” if you accept the default location for storing created 

music files or click on “Browse” to select your desired location from the 

“Choose Folder” dialog box. 

A dialog box appears and asks if you want to register Audio Manager as a default 

player. 

 

11. Click on “Yes” if you want to use Audio Manager as a default player. 

Otherwise, click on “No” in the dialog box. 

Copying of the driver software to the computer starts. 

 

12. Click on “Finish” in the “Installation Complete” dialog box. 

 

13. Click on “OK” in the dialog box that prompts you to restart your 

computer. 

 

When your computer finishes rebooting, installation of the Audio Manager and 

driver software is completed.
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� Uninstalling the Audio Manager and driver software 
 

1. Click on the “Start” button, point to “Programs” and “Audio Manager ”, 

then click on “Uninstall Audio Manager”. 

A dialog box appears and asks if you really want to uninstall the software. 

 

2. Click on “Yes” in the dialog box. 

 

3. Click on “OK” in the Uninstallation completion dialog box. 

 

Successively uninstall the driver software. 

 

4. Click on the “Start” button, point to “Programs” and “Audio Manager ”, 

then click on “Uninstall driver”. 

You are finished uninstalling when you return to the desktop. 
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2. Preparing the EV-128MRS player 
 

� Charging the battery 
Before using the rechargeable battery for the first time, charge it for about 3 

hours. 
1. Insert the rechargeable battery into 
the supplied battery charger. 
 
2. Plug the battery charger into a wall 
outlet. 
 
Note :  
The LED will be turned on while charging 
the battery.   
When charging is completed, the LED will 
be turned off. 

 

 
Recharging a completely drained battery takes about 3 hours. 

When the battery has finished charging, remove it from the battery charger and 

disconnect the battery charger from the wall outlet. 

 

� Inserting the battery 
 

 
 

1. Remove the battery compartment cover. 
 
2. Install the rechargeable battery with the 

 and  poles correctly aligned. 
 
3. Replace the battery compartment cover. 
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� Battery indicator 
The battery indicator shows the power remaining.  

 

When  appears, recharge the battery. If you continue to use the EV-

128MRS player after  is displayed, the “LOW BATT”  indicator appears, 

operation stops, and the EV-128MRS player beeps, and the player is turned off. 

 

Note on the rechargeable battery 

• Use only the supplied battery charger to recharge the battery. 

• Do NOT carry the battery in a pocket or handbag together with metal objects 

such as pendants or key holders. 

• Do NOT short-circuit the terminals by placing a metal object across them. 

• Do NOT try to disassemble the battery, heat it, or put it in water. 

• The supplied rechargeable battery can be recharged approximately 300 times. 
 

� Installing a MultiMediaCard 
Before you purchase an additional contact your nearest Evolution service 

personnel to find out which kind that works best with your EV-128MRS player. 

Before installing or removing a MultiMediaCard, be sure to turn off the EV-

128MRS player and disconnect the USB cable from it. 

 

 

1. Remove the battery compartment cover. 
 

2. Insert the MultiMediaCard into the slot in the 
correct direction, holding it with the beveled 
corner to the right. 
The mark printed on the player over the slot 
indicates the correct orientation of the card. 
 
3. Replace the battery compartment cover. 

 

To remove the MultiMediaCard 

First push the MultiMediaCard in slightly to release it. 
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� Formatting a MultiMediaCard 

In order to use a MultiMediaCard with an EV-128MRS player, you must initialize it 

to EV-128MRS format using the format function of the supplied Audio Manager. 

For details on formatting a MultiMediaCard, see “Formatting the internal Flash 

Memory and MultiMediaCard” (Chapter 3). 

 

Note on the MultiMediaCard 

• Insert the MultiMediaCard completely into the slot to ensure that it is recognized 

by Audio Manager. 

• NEVER remove the MultiMediaCard from the EV-128MRS player while Audio 

Manager is formatting it or transferring music files to the EV-128MRS player. 

Doing so may cause not only the computer to freeze up but also the memory 

media to be damaged.  

• Music files on the MultiMediaCard cannot be played back with another player. 
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3. Connecting the EV-128MRS player to your computer  

 

Use the supplied USB cable to connect the EV-128MRS player to your computer, 

as shown below. 

1. Connect the series A connector (the larger one) to the computer’s USB 

port. 

2. Connect the series B connector (the smaller one) to the USB port 

connector of the EV-128MRS player. 

3. Turn on the player by holding the  button pressed until  

“CONNECT USB” appears on the display of the EV-128MRS player. 

If you connect the USB cable to the EV-128MRS player while it is in Playback 

mode, the player will stop playback and display “CONNECT USB.” 
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Note 

If the “Add New Hardware Wizard” appears after you turn on the EV-128MRS 

player in step 3, install the USB driver, following the procedure described in 

“Installing the USB driver” (chapter 2). 

• Before connecting the EV-128MRS player to your computer with the supplied 

USB cable, be sure to fully charge the battery. 

If “LOW BATT” or “NO BATT” appears on the display of the EV-128MRS player 

when it is connected to the computer, disconnect the EV-128MRS player from the 

computer, then reconnect it after fully charging the battery. 

• The following actions are strictly prohibited while transferring music files or 

formatting the memory media. Doing so may cause not only the computer to 

freeze up but also the memory media to be damaged. 

— Disconnecting the USB cable from the EV-128MRS player or the computer  

— Removing the battery from the EV-128MRS player 

— Removing the MultiMediaCard from the EV-128MRS player 

• Do NOT turn on or off the computer while the EV-128MRS player is connected 

to the computer. This may cause damage to the EV-128MRS player or the music 

files stored on it. 

 
� Disconnecting the EV-128MRS player 
You can disconnect the EV-128MRS player from your computer whenever you 

like except during the process of transferring music files or formatting the memory 

media. 

When you disconnect the USB cable from the EV-128MRS player, it will 

automatically shut off, leaving the message “GOOD-BYE” 
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� Installing the USB driver 
 
Installation of the USB driver is automatically performed when you turn on the 
EV-128MRS player for the first time after connecting it to the computer (chapter 
2). 
 
If any problem occurs during installation of the Audio Manager software, the “Add 
New Hardware Wizard” appears when you connect the EV-128MRS player and 
turn it on. If this happens, install the USB driver by following the steps below. 
 

 
 
1. Click on “Next” in the “Add New Hardware Wizard” window. 
2. Select “Display a list of all the drivers in a specific location, so you can 

select the driver you want”, the click on “Next”. 
3. Select “Universal Serial bus controllers” from the list, then click on 

“Next”. 
4. Click on the “Have disk” button. 
5. Insert the supplied installation CD-ROM into the CD-ROM drive of your 

computer, then click on the “Browse” button. 
The “Open” dialog box appears. 
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6. Select an appropriate drive from the “Drives” drop-down menu, then 

click on “OK”. 
7. Click on “Next” after confirming that “EV-128MRS” is listed in the 

“Models” list box. 
A window appears telling you that Windows is ready to install the driver. 

8. Click on “Next”. 
The wizard begins copying the necessary files to your computer. A subsequent 
window appears when copying of files is completed. 

9. Click on “Finish”. 

 

Confirming Installation of the USB driver 
You can confirm if the USB driver is successfully installed by the following 
procedure: 
1. Check that the EV-128MRS player is connected to your computer and 

turned on. 
2. Point to “Settings” of the “Start” menu, then click “control Panel”. 
3. Double-click on the “System” icon to open the “System Properties” 

dialog box. 
4. Click on the “Device Manager” tab.   
5. Click on the  mark of the “Universal Serial Bus controllers” item.  
6. If “EV-128MRS USB driver” is listed, the USB driver is successfully 

installed. 
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Chapter 3. Using Audio Manager 

 

1. Starting Audio Manager 

To start Audio Manager, double-click on the  (Audio Manager) icon on the 

desktop. 

You can also click on the “Start” button, point to “Programs” and “Audio 

Manager,” then click on “Audio Manager.” 

 

Note  

When you start Audio Manager for the first time after installation, the following 

dialog box appears. 

 
If you have ever installed and upgraded Audio Manager, enter our e-mail address 

and click on “Connect.” If not, click on “Skip,” and “OK” in the next dialog box. 
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� Switching between the Audio Manager window and small 
player 

To switch to the small player, click on the  (Small Player) icon to the right of 

the navigation buttons bar in the Audio Manager window. 

You can also click on “Small Player” of the “View” menu. 

To switch to the Audio Manager window (big player), right-click on the area within 

the small player, then select “Big Player” from the shortcut menu.  

 

Tip 
Each time you press the F8 key, Audio Manager switches between the big player 
and small player. 
 
 
 

� To exit Audio Manager 

 

Click on  the upper-right corner of the Audio Manager window and small 

player. 

You can also click on “Exit” from the “File” menu in the Audio Manager window or 

the shortcut menu of the small player that appears when you right-click. 

 

� Changing the appearance of the Audio Manager window 
In Audio Manager, several skins of different design are available, which allow you 

to change the appearance of your Audio Manager window (also of the small 

player) to suit your preference. 

Click on “Link to more skins” of the “Skins” menu in the Audio Manager window to 

connect to the Web site, where you can find and download skins of your 

preference. 

When you are displaying the small player, click on “Skins” from menu of the small 

player that appears when you right-click. 
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2. Identification of Audio Manager controls 

 
� Audio Manager window 

To make full use of the EV-128MRS player, you need to learn how to use the 

basic functions of the Audio Manager. 

          
                (Audio Manager with the Play List Window opened)                                      
  

 Menu bar 
Clicking on an item opens a drop-down menu from which you can select 

commands. The following is the “View” menu opened by clicking on the “View” 

item on the menu bar. 

 
To learn how each menu command functions, refer to the “Quick Reference” book 

in the Online Help window. 

 Audio Manager navigation buttons 

 make a playlist button 

Click on this button to open the Play List window, which allows you to listen to 

tracks and organize tracks into play lists as you like, such as by artist, genre, etc. 

(chapter 3-5). 
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 copy to devices button 
Click on this button to open the Copy to Devices window, which allows you to 
transfer tracks from your computer to your EV-128MRS player (chapter 3-6). 
The Copy to Devices window also allows you to view a list of tracks and delete 
tracks stored on the memory media. 
 

 write audio cd button 
Click on this button to open the Write CD window, which allows you to record 
tracks from your computer on a CD-R. 
 
Note 
EV-128MRS does not support the functions available in the Write CD window. 
For detailed information about the Write CD window, refer to the “Write to a CD” 
book in the Online Help window. 
 

 read a cd button 
Click on this button to open the Read a CD window, which allows you to record 
tracks from a music CD to your computer (chapter 3-3). 
 

 go to web button 
Click on this button to connect to the WindowsMedia.com Web site (chapter 3-4). 
 

 Small Player icon 
Click on this icon to transform Audio Manager into a Small Player. 
For a description of each control, see “Player controls” (chapter 3-5-5). 
 

 
 
When you start playing back tracks on Small Player, the WhiteCap window 
appears giving representations with 3-D curve graphics. 
 
Note 
Minimizing Small Player causes the WhiteCap window to disappear. To restore 
the WhiteCap window, quit audio Manager and restart it. 
 
Tip 
You can display each window using the “Navigation” command of the “View” 
menu instead of using above buttons. 
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3. Recording tracks from a music CD   

 

� Read a CD window 

The Read a CD window allows you to record selected tracks from a music CD or 

record an entire music CD at once. The recorded tracks can be transferred to 

your EV-128MRS player for playback. 

 
 Read a CD button bar 

 button 

Click on this button to obtain information about the inserted music CD from the 

CDDB server on the Internet (chapter 3-3). 

The CDDB service may require a charge in the future. If you want to keep using 

the CDDB service at this time, a license will be provided by the CDDB service. 

 button 

Click on this button to open the “Preview Play List” window, which allows you to 

edit the CD or track information manually. 

 button 

Click on this button to start recording tracks from a music CD. 

 button 

Click on this button to stop recording. 
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 Read a CD Track list 

Displays information about the loaded music CD, such as an album title, and the 

title, artist, and length of each track on the music CD.  

Select the tracks you want to record by clicking on the box to the left of each 

track. 

 

 Read a CD Track list button bar 

 button 

Click on this button to reload information on the music CD. 

 button 

Click on this button to select all the tracks on the list for recording. All the boxes 

to the left of the tracks are checked at once. 

 button 

Click on this button to clear the check marks for all the tracks on the list at once. 

 

 Track Details box 

Displays information about the selected track, such as the title, artist, playing time, 

album title, category, and lyrics. You can view more detailed information and edit 

it by clicking on the “Edit Track Info” button. 

 

 Status box 

Displays the current progress of the recording process. The upper status bar 

displays the recording progress of the track currently being processed, and the 

lower status bar shows the overall recording progress for all the tracks selected 

for recording.  
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� Recording tracks 

 
Before starting 

Before starting you may confirm and change the settings to use when recording 

tracks from a music CD by following the steps below. 

To learn more about setting preferences, refer to the “Set Preferences” book in 

the Online Help window. 

 Click on “Options” of the “View” menu to open the “Options” dialog box.  

 Under the “Read CD” tab, confirm the following settings and change them if 

necessary. 

Drive: 

Choose the CD-ROM drive to use when recording tracks from a music CD. If you 

have multiple CD-ROM drives in your computer, you can change the current CD-

ROM drive by clicking on  to the right of the “Drive:” field. 

Record File As: 

Choose the file format to use when recording tracks from a music CD by clicking 

on  to the right of the “Record File As:” field. You can choose between “Mpeg 

(.mp3)” and “Microsoft Windows Media Audio (.wma).” 

Bit Rate: 

Select the bit rate to be used to encode tracks recorded from a music CD. Click 

on  to the right of the “Bit Rate:” field, then select one of items. Higher bit rates 

create files with better sound quality, but larger file sizes result in less total 

recording time that can be stored on the memory media. 

Note 

• The EV-128MRS player supports WMA and MP3 files encoded with a following 

bit rate. Files encoded with other bit rates may cause inaccuracy of elapsed 

playing time indicated on the display and sound skip. 

—  WMA files encoded with a bit rate of 64, 80, 96, 128, or 160 kbps 

—  MP3 files encoded with a bit rate of 64, 80, 96, 128, 160, 192, 256, or 320 

kbps. 

• Be sure not to check the “Protect files for use on this machine only” option in the 

“Bit Rate:” field, if you want to play back the encoded files on another computer or 

transfer them to the EV-128MRS player using another computer. 
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 Under the “CDDB” tab, check the “Always get title from CDDB when CD is 

inserted” option by clicking on it if you want information about a music CD to be 

obtained automatically.  

If you check this option, you can obtain general information about a music CD, 

such as album title, track titles, artist name, and playing time from the CDDB* 

server on the Internet. 

Otherwise, leave this option unchecked. 

You must have Internet access to use CDDB. 

* The disc-recognition service provided via the Internet by CDDB, Inc. 

1. Double-click on the  icon on the desktop to start Audio Manager. 

2. Insert the music CD from which you wish to record tracks into the CD-

ROM drive of your computer. 

If the Play List window is open and any tracks remain on the list, the “New CD   

Detected” dialog box appears, asking you to select “Play this CD,” “Append to 

Play List,” or “Cancel.” If this dialog box appears, click on “Cancel” in the dialog 

box. 

 

3. Click on the “  read a cd” button to open the Read a CD window. 

The Read a CD window appears with all the tracks on the music CD checked for 

recording. 

If you did not check the “Always get title from CDDB when CD is inserted” option 

mentioned above, the dialog box appears and prompts you to obtain information 

about the inserted music CD automatically. Now, click on “No”  so you can edit 

information manually. 

 

If you want to record the entire music  CD into your computer, skip steps 4 and 5, 

and go to step 6. 
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4. Click on the “Untag All” button to clear the check marks for all the tracks 

on the “Read a CD Track” list. 

5. Select the tracks that you want to record into your computer by clicking 

on the box to the left of each track. 

To cancel a selection, click on the box 5again. 

Tip 

If you are not sure that the track you selected is correct, right-click on the track, 

then select “Play” from the drop-down menu to hear it. 

6. Edit track information. 

  

The “Preview Playlist” window appears. 

 

 Select the track that you want to edit, then click on the “Review/Edit” button. 

The “Edit CD Track Information” dialog box appears. 

 
 Enter information about the track such as the title, artist, album title, genre, 

and lyrics. 

In some fields, you can select the desired item from the drop-down list by clicking 

on to the right of the field. 



 
 

EV-128MRS User’s Guide 

 32 

 Click on “Next” once or more times to go to the next track to edit. When you 

have no more tracks to edit, click on “Close.” 

 Click on “Close” to close the “Preview Playlist” window. To learn more about 

how to use the “Edit CD Track Information” dialog box, refer to the “Edit Track 

Information” under the “Play List” book in the Online Help window. 

 

7. Click on the “Start Reading” button. 

The recording process for the selected tracks starts. The Status box displays the 

progress of the track currently being recorded and the total recording progress of 

all the tracks selected for recording.  

To stop recording, click on the “Stop Reading” button. 

When the entire track is successfully recorded, the dialog box stating that 

recording is completed successfully appears. 

 
If you are going to record tracks from a CD for the first time, the “Testing CD 

drive...” dialog box appears stating that your system and CD-ROM drive is being 

tested. Through this process, your system and CD-ROM drive will be 

automatically configured and optimized for recording. 

Note 

As to MP3 format, the number of times allowed for encoding is limited to 50. If 

you try to record tracks from a music CD past that limit, a message notifying you 

of that will appear once you click on the “Start Reading” button. If this happens, 

you can use WMA file format, which has no such limitation. 

8. Click on “OK.” 

The recorded tracks are added to your database. 

 

Now you are ready to go to “Creating a play list” (chapter 3-5). 
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� Obtaining track information about a music CD automatically 
If you have access to the Internet, you can obtain information about the music CD, 

such as the album title, track title, and artist name, automatically from the CDDB 

on the Internet. 

The CDDB is a database accessible via the Internet, which stores track 

information regarding a vast amount of music CDs from all over the world. If your 

music CD is recorded in the database, the track information about the CD will be 

added to your list. If not, no change will be made to the list. In such a case, you 

are left with entering the information manually.  

To get track information about your music CD, perform the following.  

1. Confirm that you are connected to the Internet. 

2. Insert the music CD into the CD-ROM drive of your computer. 

A dialog box appears asking you if you want to get information about the CD from 

the Internet. 

  

3. Click on “Yes” in the dialog box. 

The connection to the CDDB is automatically established, and downloading starts. 

4. When downloading is finished, information about your music CD will be 

displayed on the list. 

Tip 

You can get information at any time you like, but before you start recording, by 

clicking on the “Get Track Titles” button, even if you clicked “No” in step 3 in 

“Recording tracks” (chapter 3-3). If you click on the “Refresh” button the above 

dialog box will appear. 
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4. Obtaining music files via the Internet 
Audio Manager provides easy and convenient means to stream music, download 

music clips, and purchase music via the Internet. Clicking on a single button 

automatically connects you to the WindowsMedia.com Web site, where you can 

find vast amounts of music downloads covering almost all popular artists in the 

world and genres, a variety of entertainment contents such as movies and radio,  

information about hardware and software. This site also provides many links to 

other entertainment Web sites. 

Note 

You must have Internet access to download music via the Internet. 

 

1. Click on the “  go to web” button on the Audio Manager window. 

The WindowsMedia.com Web site appears. 

2. Search for desired music through links of your preference, or enter a 

different Web site address in the address field if you know it.  

3. When you find your desired music file, start downloading it by clicking 

on the “Download” button or other such button that may be displayed in a 

particular case. 

The “File Download” dialog box appears. 

 

Note 

With most contents provider on the Internet, you may be required to fill in 

information on an enrollment form for membership before you can download 

music files. 
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4. Check the “Save this file to disk” option and click on “OK.” 

The “Save As” dialog box appears. 

 

5. Check that “My Music” is entered in the “Save in” field, enter a filename 

if necessary, then click on “Save.” 

Downloading starts. When downloading is finished, the “Download complete” 

dialog box appears. 

6. Click on “OK” in the dialog box. 

Now you are ready to play the downloaded music file on the Audio Manager and 

your EV-128MRS player. 

For detailed information about obtaining downloadable music files, refer to the 

“Visit the Internet to get audio and video” and “Play Secure Media” books in the 

Online Help window. 

Note 

Most downloadable music files are delivered in a secure files that have encrypted 

information for copyright protection written in them. Therefore, you may be 

restricted as to playing back and transferring downloaded music files. 
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5. Organizing tracks using play list 

 
� Play List window 

You can use the Play List window to view all the tracks stored on your computer, 

as well as to create play lists and add selected tracks to them. The Play List window also 

allows you to play back the tracks you added from your database* to the Play List. 

If you save the tracks displayed on the Play List as a play list, you can easily 

prepare a number of tracks for transfer to your EV-128MRS player. 

* Music files recorded or downloaded to your computer using Audio Manager 

are automatically added to your database. Music files already on your 

computer can be also added to your database. To learn more about the 

database, refer to the “Tracks Database” and “Play List Database” books in 

the Online Help window. 

 

 Add Tracks to the Play List button bar 

 button 

Click on this button to select desired tracks from your database and add them to 

the Play List. 

 button 
Click on this button to select desired play lists from your database and add the 

tracks contained in them to the Play List at once. 
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 button 

Click on this button to add the tracks from the music CD in the CD-ROM drive of 

your computer to the Play List. 

 Play List 

Displays the list of the tracks you have added from your database or the music 

CD in the CD-ROM drive of your computer. Each track has information such as 

the track title, artist name, original album title and playing time, and also an icon 

that represents its file type. 

 A track in MP3 file format 

 A track in WMA file format (Windows media Audio) file format An icon 

preceding the track in the Play List indicates the play status of the track (stopped, 

in play, or play paused.) this icon changes among ,  and  depending on 

the play status of the track. 

 Organize the Play List button bar  

 button 

Click on this button to clear all the tracks from the Play List. 

 button 

Click on this button to save the tracks displayed on the Play List as a play list, 

which gives you an easy way to access these grouped tracks for playback and 

transfer to your EV-128MRS player. 

 button 

Click on the trash can to delete the selected track from the Play List. 

 button 
Click on this button to move a selected track up in the Play List order. 

 button 

Click on this button to move a selected track down in the Play List order. 

   Track Details box 

Displays detailed information about the selected track, such as the track title, 

artist name, original album title, ratings, artwork, and lyrics. 

You can edit these details by right-clicking on the track and selecting the “Edit 

Track” menu command. 
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 Player controls 

Provide basic functions for playing back tracks with Audio Manager. 

 

 Elapsed playing time indicator 

 Input level indicator 

 Balance control slider 

  Drag the slider to adjust the balance between the left and right speakers. 

 Volume control slider 

  Drag the slider to the right or left to adjust the volume. 

 Repeat play button 

  Plays the current track repeatedly. 

 Shuffle play button 

  Plays all tracks in random order. 

 Track Position slider 

  Drag the slider to start playback at a different position within the track. 

  (Backward) button 

  Plays the previous track. 

  (Play) button 

  Starts playback of the selected track. 

  (Pause) button 

  Pauses playback. To resume playback, click on  again or click on 

. 

  (Stop) button 

  Stops playback. 

  (Forward) button 

  Plays the next track. 
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� Creating a play list 
1. Click on the “  make a playlist” button to open the Play List window if 

it is not already open. 

2. Click on the “Clear List” button to clear the tracks already in the Play List. 

3. Click on the “Select Tracks From Database” button. 

The “Select Tracks From Database” window appears. 

You can also click on the “Select Playlist from Database” button instead if you 

have already created play lists. 

  
4. Select the tracks that you want to add to the new play list by clicking on 

the box to the left of each track. 

To cancel the selection, click on the box again. 

5. Click on “OK” when you have finished selecting the tracks. 

The selected tracks are displayed in the Play List. 

If there is any track that you want to exclude from the selections, select it and 

click on . 

6. Click on the “Save Tracks as Playlist” button. 

The “Add Playlist” window appears. 
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7. Name the new play list and fill in the other information fields under the 

“Description” tab. 

8. If necessary, enter information about the tracks contained in the new play 

list in the “Edit Track Info” dialog box that can be opened by right-clicking 

on the area within the list, then selecting the “Edit Track...” menu command 

under the “Track List” tab. 

9. Click on “Close” in the “Add Playlist” window when you have finished. 

The dialog box stating that the play list has been saved appears. 

10. Click on “OK.” 

You can find the new play list in the “Select Playlist From Database” window that 

can be opened by clicking on the “Select Playlist From Database” button on the 

Play List window.  

Now you are ready to transfer the tracks to your EV-128MRS player. 

 

Functions available in the Select Tracks From Database window 

Following operations are available in the “Select Tracks From Database” window: 

• Sort the track order by track title, artist name, original album title or playing time 

by clicking on the corresponding column label. 

• Use the “Find:” field to locate your target track easily. Click on the label of the 

column that you want to search, then type the name of the target track in the 

“Find:” field that you can find under that column. 

• Edit track information by clicking on the “Edit” button after selecting the track. 

• Listen to the track by right-clicking on the track and selecting “Play” from the 

shortcut menu. This is helpful when you are not sure that the track you selected 

is correct.  

Also in the “Select Playlist From Database” window, similar operations are 

available with play lists. 
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� Creating a play list so that it contains music files  
  already on your computer 

 
If you know where the music files are stored 

1. Click on the “  make a playlist” button to open the Play List window if 

it is not already open. 

2. Click on the “Clear List” button to clear the tracks on the Play List.  

3. Click on “Add Tracks” of the “File” menu to open the “Add Tracks” 

dialog box. 

 
4. Select the music files that you want to add to the play list, then click on 

“Open.” 

The selected music files are automatically added to your database and displayed 

on the Play List.  

5. Click on the “Save Tracks as Playlist.” 

6. Name the new play list, fill in the other fields, then click on “Close.” 

7. Click on “OK” in the dialog box that appears successively.  

 

If you do not know where the music files are stored 

1. Cilck the “  make a playlist” button to open the Play List window if it is 

not already open. 

2. Click on the “Clear List” button to clear the tracks on the Play List. 

3. Click on “Search Hard Disks for Tracks” of the “File” menu. 

All the music files stored on your computer are automatically added to your 

database and displayed on the Play List. 

4. Click on the “Clear List” button to clear the tracks on the Play List. 

5. Click on the “Select Tracks From Database” button. 

The “Select Tracks From Database” window appears. 
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6. Select the tracks that you want to add to the new play list by clicking on 

the box to the left of each track, then click on “OK” when you have finished. 

The selected tracks are displayed in the Play List on the Play List window. 

7. Click on the “Save Tracks as Playlist.” 

8. Name the new play list, fill in the other fields, then click on “Close.” 

9. Click on “OK” in the dialog box that appears successively.  

 

Note 

Choosing the “Search Hard Disks for Tracks” option in step 3 brings up all the 

music files, including those transfer of which the EV-128MRS player does not 

support, such as .wav and RA files, to the Play List. 

 

� Adding tracks to the previously created play list  

 
1. Click on the “  make a playlist” button to open the Play List window if 

it is not already open. 

2. Click on “Select Playlists From Database” button. 

The “Select Playlists From Database” window appears. 

3. Select the play list to which you want to add the tracks by clicking on the 

box to the left of the play list, then click on the “Edit” button. 

The “Edit Playlist” window appears.  

4. Click on the “Add Track” button under the “Track List” tab. 

The “Select Tracks From Database” window appears. 

5. Select the tracks that you want to add to the play list by clicking on the 

box to the left of each track, then click on “OK.” 

6. Click on “Close” after confirming that the selected tracks are added to 

the list in the “Edit Playlist” window. 

7. Click on “Yes” in the dialog box asking you if you really want to save the 

changes. 

 

8. Click on “OK” in the “Select Playlists From Database” window. 

 



 
 

EV-128MRS User’s Guide 

 43 

 

� Deleting tracks from the previously created play list 
 

1. Click on the “  make a playlist” button to open the Play List window if 

it is not already open. 

2. Click on “Select Playlists From Database” button. 

The “Select Playlists From Database” window appears. 

3. Select the play list from which you want to delete the tracks by clicking 

on the box to the left of the play list, then click on the “Edit” button. 

The “Edit Playlist” window appears. 

4. Select the track that you want to delete from the play list, then click on 

. 

You can also use the shortcut menu that appears when you right-click to delete 

the selected track. 

5. Repeat step 4, if necessary.  

6. Click on “Close” when you have finished. 

7. Click on “Yes” in the dialog box asking you if you really want to save the 

changes. 

 

8. Click on “OK” in the “Select Playlists From Database” window. 
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� Deleting tracks and play lists from your database 
 

Deleting tracks from your database 

1. Click on the “  make a playlist” button to open the Play List window if 

it is not already open.  

2. Click on the “Select Tracks From Database” button to open the “Select 

Tracks From Database” window. 

3. Click on the track you want to delete to highlight it, then click on the 

“Delete” button. 

 
A dialog box appears and asks you if you really want to delete the track. 

NEVER check the “Delete the track file from hard disk” option unless you are 

sure you want to delete the track, or you may lose your music files forever. 

4. Click on “Yes.” 

5. Repeat the procedure for the remaining tracks. 

6. Click on “OK” when you have finished. 

 

Tip 

Instead of using the “Delete” button, you can use the shortcut menu that appears  

when you right-click to delete all the selected tracks at once. 

Select the tracks you want to delete by clicking on the box to the left of each track, 

then right-click on the area within the list and select “Delete Tagged Tracks” from 

the shortcut menu. 
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Deleting play lists from your database 

1. Click on the “  button to open the Play List window if 

it is not already open. 

2. Click on the “Select Playlists From Database” button to open the 

“Select Playlists From Database” window. 

3. Click on the play list that you want to delete to highlight it, then click on 

the “Delete” button. 

A dialog box appears and asks you if you really want to delete the play list. 

4. Click on “Yes.” 

5. Repeat the same procedure for the remaining play list. 

6. Click on “OK” when you have finished deleting all the play lists. 

Tip 

Instead of using the “Delete” button, you can use the shortcut menu that appears 

when you right-click to delete all the selected play lists at once. 

Select the play lists you want to delete by clicking on the box to the left of each 

play list, then right-click on the area within the list and select “Delete Tagged 

Playlists” from the shortcut menu. 
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� Editing track information  

You can edit track information anywhere you can find the “Edit...” button or “Edit 

track...” drop-down menu command within Audio Manager. Suppose you are in 

the “Select Tracks From Database” window.  

You can click on the “Edit” button to open the “Edit Track Info” dialog box, which 

allows you to enter or select information about the tracks listed in the window, 

such as the track title, artist name, original album title and genre. 

  

Note 

If you edit information about the tracks in MP3 file format within Audio Manager,  

track information will be saved in ID3v2 tag format. 

To learn more about how to work with the “Edit Track Info” and “Edit Play Lists 

 dialog boxes and meaning of the fields contained in the dialog boxes, refer 

to the “Work with Tracks” book in the Online Help window. 

 

� Playing the tracks in the play list 
1. Click on the “  make a playlist” button to open the Play List window if 

it is not already open. 

2. Click on the “Clear List” button to clear the tracks on the Play List. 

3. Click on the “Select Playlists From Database” button. 

The “Select Playlists From Database” window appears. 

4. Select the desired play list by clicking on the box to the left of the play 

list, then click on “OK.”  

5. Click on the desired track, then click on . 
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� Playing the tracks on the music CD 

1. Click on the “  make a playlist” button to open the Play List window if 

it is not already open. 

2. Click on the “Clear List” button to clear the Play List. 

3. Insert the music CD into the CD-ROM drive of your computer, or click on 

the “Get Tracks From CD” button if the music CD is already in the CD-ROM 

drive. 

If you do not clear the list in step 2, the “New CD Detected” dialog box appears 

when you insert the CD into the CD-ROM drive and asks you to select “Play this 

CD,” “Append to Playlist,” or “Cancel.” 

 

• Click on “Play this CD” to delete the current entries in the Play List and replace 

them with the tracks on the CD. The CD will begin playing. 

• Click on “Append to Playlist” to add the tracks on the CD to the tracks already in 

the Play List. 

4. The tracks contained on the music CD are displayed on the Play List. 

If you did not check the “Always get title from CDDB when CD is inserted” option, 

a dialog box appears and prompts you to obtain information about the inserted 

music CD automatically. If you want to get information about the music CD, click 

on “Yes.” Otherwise, click on “No.” 

5. Click on the desired track, then click on . 
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� Shortcut menus 

With most of the windows of Audio Manager, there is a shortcut menu that 

appears when you right-click. Right-clicking on a track or play list opens a 

shortcut menu that allows you to easily select a frequently used command. 

Below is the shortcut menu opened by right-clicking on the track listed in the Play 

List window. 

 

Note 

Any grayed-out menu command is disabled. So you cannot select it. 
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6. Transferring tracks to the EV-128MRS player 
 

To enjoy listening to music on the EV-128MRS player, you must transfer music 

files stored on your computer to your EV-128MRS player. You can use Audio 

Manager to transfer MP3 files as well as WMA (Windows Media Audio) files to 

the EV-128MRS player. 

 
� Copy to Devices window 

The copy to Devices window allows you to select tracks or play lists from your 

database and transfer them to your EV-128MRS player. 

This window also provides the facility to manage to portable player connected to 

your computer such as formatting memory media on the portable player and 

deleting tracks from the memory media. 

 
 
 

  Device window button bar 

 button 
Click on the button to select desired tracks from your database and add 
them to the Transfer List. 

 button 
Click on this button to select desired play lists from your database and add 
them to the Transfer List. 

 button 
Click on this button to start transfer. 
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  Transfer List 
Displays the list of the tracks you have selected from your database for 

transfer to your EV-128MRS player. Each track has information such as the 

playing time, size, track title and artist name, and also an icon that 

represents its file type. 

 button A track in MP3 file format 

 button A track in WMA file format 

An icon preceding the track on the Transfer List indicates the play status on 

the track (stopped, in play, or play paused.) this icon changes among ,  

and  depending on the play status of the track. 

 

  Organize the Transfer List button bat 
 button 

Click on this button to clear all the tracks from the Transfer List. 

 button 

Click on this button to save the tracks displayed on the Transfer List as a 

play list, which gives you an easy way to access these grouped tracks later. 

 button 

Click on the trash can to delete the selected track from the Transfer List. 

 button 

Click on this button to move a selected track up in the Transfer List order. 

 button 

Click on this button to move a selected track down in the Transfer List order. 

 

  Memory media drop-down list 
Displays the currently selected memory media. If your EV-128MRS player has a 

MultiMediaCard in the slot, select either “Internal Memory(Flash)” or ” ”External 

Memory(MMC)” to which you wish to transfer tracks by clicking on  button.
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  Device Usage bar 

Gives you a graphic representation of current memory usage status of the 

memory media selected in the “Media:” field. 

 

  Portable Track List 
Displays the list of the tracks stored on the currently selected memory media 

including the track title and size for each track. 

 

  Portable Track List button bar 

 button 

Click on this button to redisplay the Portable Track List to match the contents 

of the selected memory media. 

 button 

Click on this button to display information about restrictions on transferring 

music files to the EV-128MRS player. 

button 

Click on this button to initialize the memory media (internal and external) on 

the EV-128MRS player. 

You can usefully use this button when you want to delete all the tracks from 

the memory media. 

 button 

Click on the trash can to delete the selected track from the Portable Track 

List. Note that this causes the track not only to disappear from the list but 

also to be deleted from the memory media. 

 button 

Click on this button to move a selected track up in the Portable Track List 

order. 

 button 

Click on this button to move a selected track down in the Portable Track List 

order. 
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� Transferring tracks to the EV-128MRS player 

 
Before starting 

• Before connecting the EV-128MRS player to your computer, be sure to fully 

charge the battery. 

• Check that the internal Flash Memory or MultiMediaCard has enough available 

memory to store the transferred tracks.  You can find this information in the 

Device Usage bar. 

• Check that files to be transferred are not encoded with a bit rate or sampling 

frequency outside the range supported by the EV-128MRS player. For more 

information about the supported bit rates and sampling frequencies, see chapter 

5. 

• The following actions are strictly prohibited while transferring music files. 

Doing so may cause not only the computer to freeze up but also the memory 

media to be damaged. 

— Disconnecting the USB cable from the EV-128MRS player or the computer 

— Removing the battery from the EV-128MRS player 

— Removing the MultiMediaCard from the EV-128MRS player 

 

1. Connect your EV-128MRS player to your computer (chapter 2-3). 
 
2. Turn on the player by holding the  button pressed until 

“CONNECT USB” appears on the display of the EV-128MRS player. 
 

3. Click on the “  copy to devices” button to open the Copy to Devices 
window if it is not already open. 
 

4. Click on the  to the right of the “Media:” field and select “Internal 
Memory (Flash)” or “External Memory (MMC)” from the drop-down list. 

 
 
 
Note  
If you select the MultiMediaCard as a memory media, it takes more time to finish 

transferring tracks. 
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5. Format the selected memory media if necessary (chapter 3-6). 
6. Click on the “Clear List” button if any tracks are listed on the Transfer 

List. 
7. Click on the “Select Tracks From Database” button. 

The “Select Tracks From Database” window appears. 
 

Tip 
If you have created a play list that contains the tracks selected for transfer, you 
can select the play list from the “Select Playlists From Database” window that can 
be opened by clicking on the “Select Playlists From Database” button. 

 
8. Select the tracks that you want to transfer to the EV-128MRS player by 

clicking on the box to the left of each track, then click on “OK.” 
You will be notified if you have selected too many tracks for the selected 
memory media. 

 
If this dialog box appears, you must delete on or more tracks from the Transfer 
List or Portable Track List until the total size of the selected tracks falls below 
the available memory of the memory media. 
 

9. Click on “Close” to close the dialog box. 
 
10. Delete the tracks on at a time until the red porting of the Device Usage 

bar disappears by clicking on  after selecting the track on the 
Transfer List or Portable Track List. 

 
11. When you are all right with your selection, click on the “Copy To 

Portable” button.  
Transfer of the selected tracks starts and the “Sending to device” dialog box 

appears, where you can see the transfer status of each track and the track title 

currently being transferred. On the EV-128MRS player, “NOW 

DOWNLOADING PLEASE WAIT” remains displayed while transfer is in 

progress. 
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Tracks are transferred to your EV-128MRS player in the order they appear on 

the Transfer List.   

To cancel transfer, click on the “Abort” button of the dialog box. 

 

Note 

If you transfer the selected tracks to memory media that contain one or more 

files, transfer is not performed in the order tracks are listed. The size of each 

track selected is compared against that of the remaining available memory 

each time before starting transfer of a track, and the track the size of which 

best fits the remaining available memory is transferred. Transfer stops when 

not enough space to store any of the remaining tracks remains on the memory 

media. 

 

12. Click on “OK” when the message “Finished transferring tracks” is 

displayed. 

Your EV-128MRS player is now ready for playback. 

 
Note 

• The track currently being played back cannot be transferred to the EV-128MRS 

player. 

• You are constrained to playing the tracks on the MultiMediaCard on the original 

EV-128MRS player that was used to transfer music files. 

• Music files cannot be restored to your computer after they have been 

transferred to the EV-128MRS player. 

• The filename extension of and MP3 file will be changed from “.mp3” to “,mpm” 

because of copyright protection measures after transferring it to the EV-128MRS 

player. 

• Up to 250 music files can be transferred to the EV-128MRS player internal 

Flash Memory and the MultiMediaCard. 
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� Viewing current memory usage status of the memory media 

 
The Device Usage bar located on the right pane of the Copy to Devices window 
gives you color-coded representation of current memory usage status of the 
selected memory media. 

 

�Green 

 The amount of memory currently being used on the memory media 

�Yellow 

The amount of memory necessary for transferring the selected tracks 

�Grey 

The amount of available memory remaining after transferring the selected tracks 

�Red 

The amount of memory shortage when all the selected tracks are transferred 
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� Deleting tracks from the memory media 

 

1. Click on the track that you want to delete from the Portable Track List. 

2. Click on . 

The selected track is deleted from the memory media. 

You can also right-click on the track, then select “Remove” from the shortcut 

menu. 

Tip 

If you want to delete all the tracks from the memory media, you may use the 

“Format Media” button. 

 

� Increasing the number of files that can be transferred  

  to the EV-128MRS player 

 

You can transfer more files to the EV-128MRS player by selecting a bit rate lower 

than that of the tracks selected for transfer. 

1. Click on “Options” of the “View” menu to open the “Options” dialog box. 

2. Click on  to the right of the “Bit Rate:” field, then select a bit rate 
lower than that used to encode the selected tracks under the “Read CD” tab. 

This causes the files to be reduced in size, resulting in increasing the number 

of files to be stored on the memory media. 
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� Formatting the internal Flash Memory and MultiMediaCard 
 
Before starting 

• Formatting the memory media erases all contents stored on it. 

• The following actions are strictly prohibited while formatting the memory media. 

Doing so may cause not only the computer to freeze up but also the memory 

media to be damaged.  

— Disconnecting the USB cable from the EV-128MRS player or the computer 

— Removing the battery from the EV-128MRS player  

— Removing the MultiMediaCard from the EV-128MRS player 

• Check that there is sufficient power remaining. 

1. Connect the EV-128MRS player to the computer with the supplied USB 

cable. 

If it is a MultiMediaCard that you want to format, insert it into the EV-128MRS 

player before connecting the EV-128MRS player to the computer. 

2. Turn on the player by holding the button pressed until “CONNECT 

USB” appears on the display of the EV-128MRS player. 

3. Double-click on the (Audio Manager) icon on the desktop. 

4. Click on the “  copy to devices”  button to open the Copy to Devices 

window if it is not already open. 

5. Click on  to the right of the “Media:” field and select the desired 
memory media “Internal Memory (Flash)” or “External Memory (MMC)” from 

the drop-down list. 

6. Click on the “Format Media” button. 
The following dialog box appears. 

 
7. Click on “OK” if you are sure you want to format the selected memory 

media. 
When “NOW FORMATTING PLEASE WAIT” changes to “FORMAT 
COMPLETED!” on the EV-128MRS player, formatting is completed. 
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Chapter 4.  USING THE EV-128MRS PLAYER 

1. Player overview 
 

� Main unit 

 
 PRESET –/AREA/PLAY MODE button 

• Press during playback to select the desired play mode from among NORMAL, 

1 REPEAT, ALL REPEAT, RANDOM, and RANDOM REPEAT.  

 

  (play / pause) /  (off) button  

• Press and hold to turn the power on for a few seconds and start playback, or to 

turn the power off. 

 

 AàB button 

• Press during playback to set AàB repeat playback. 

 

 HOLD switch 

When the player is not being used, set it to the HOLD position to prevent 

unintentional operation. 
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 Multi Jog / Status Information 

• Turn up or down during playback to skip to the beginning of the desired track. 

• The sampling rate, bit rate and remaining flash memory size are displayed. 

  

 VOLUME +/– button 

• Press to increase or decrease volume. Each time you press the button, volume 

increases or decreases by one step.  

• Press and hold to continuously increase or decrease volume. 

• Volume is adjusted between 0 and 20. 

Note 

If you adjust the volume between the level of 14 and 20, it is automatically set to 

13 when you turn the power on after turning it off. 

 
 BASS OFF/ON button 

“ON” to set the BASS sound quality. 

 

 AUTO PRESET/EQ button 

• Press repeatedly during playback to select the desired EQ mode. 

 Display window  

(Headphones) jack (stereo mini-jack) 

Used to connect the supplied headphones control. 

 USB port connector 

Used to connect the series B (smaller) connector of the supplied USB cable to 

the player and the series A (larger) connector to the USB port of your computer. 

 Battery compartment cover 

 MultiMediaCard slot 
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� Display window 
 

During playback 

 

 Play mode indicator 

 EQ indication 

 Repeat indication  

 Battery indicator 

Displays the remaining battery power. 

 Main indication 
Displays the track number and elapsed playing 
time of the current track when the DISPLAY 
switch is set to the TIME position. 
 

 Displays the track title of the current track 
when the DISPLAY switch is set to the TITLE 
position. 
 
Note 
During playback of WMA files, the timer display 
may show irregular behavior, especially when 
you skip to another track. 
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2. Using the player     

 
� Playing back tracks 

 

 

 

 

Before starting 
Release the HOLD switch to activate the player 
buttons. 
1. Connect the supplied headphones to the 

 jack on the player. 
You can connect the headphones directly to the 

jack as well. 
2. Press and hold the /  button until 
“DIGITAL AUDIO” appears on the display. 
Playback starts automatically from the 

beginning of the track that was played back last 

time. 

3. Adjust the volume with the VOLUME + or 
– button.  
 
Note 
The EV-128MRS player allows you to play 

back up to 250 music files that have been 

stored on it. 

To turn the power off 
Press and hold the /  button until “GOOD-BYE” appears on the display. 
On the pause state, the power will be off after 4 minutes. 
 
To put the player in playback pause 
Press the /  button during playback. To resume playback, press the 

/  button again. 
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To search for a track 
Turn the Multi Jog up or down repeatedly during playback or playback pause until 
a desired track is located. 
Holding the Multi Jog up or down during the pause state will move the tracks 
quickly. 
 
To search for a point of a track 
During playback, hold turning up or down the Multi Jog until the desired point of 
the track is located. 
 
Status Information 
Pressing the Multi Jog for a seconds will display the current track information and 
the remaining memory. 
“S/R:xxxkHz ” : sample rate of the current track 
“B/R:xxxkbPS” : bit rate of the current track 
“F/M:xxxMB” : available memory size 
 
 

� Selecting a play mode 

 

Press the PLAY MODE button repeatedly 
during playback to select the desired play 
mode. 
 
 

Select   To play 
Normal All the recorded tracks in order. 

When you are using the player with a MultiMediaCard loaded, 
playback starts from the Flash Memory, and then proceeds to the 
MultiMediaCard after the last track in the Flash Memory ends. 

1Rep The current track repeatedly 
AllRep All recorded tracks repeatedly 
Random All recorded tracks in random order 
RndRep All recorded tracks in random order repeatedly 
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� Playing a desired portion of a track repeatedly  
  (A-B Repeat Playback) 

 

1. Press the A-B button at the beginning of 
your desired portion during playback. 
“Aà” appears on the display. 
2. Press the A-B button at the end of your 
desired portion during playback. 
The player starts to play the portion between 
point A and B repeatedly. 
 

To cancel A-B Repeat Playback 

Press the A-B button during A-B playback. 

 
 

� Selecting equalizer settings to suit tracks 

 

 

Press the EQ button repeatedly during 
playback to select your desired EQ mode 
from among ROCK, POP, JAZZ, and 
CLASSIC. 
 
Note :  
The BASS batton should be “OFF” to 
operate “EQ” 
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Chapter 5. Appendix  

1. Specifications    

 
Storage media Built-in 128MB Flash Memory  

MultiMediaCard slot for a removable 8MB,16MB, 
32MB, 64MB MultiMediaCard 

Maximum  
output level 

5 mW + 5 mW (32 Ω) 

Frequency range 20 Hz – 20 kHz 
Load impedance 16 – 32 ohms 
S/N ratio 85 dB 
Distortion rate 0.2 or less 
Power supply 1.2 V DC using the supplied 

MHB-901 Ni-MH rechargeable battery 
Continuous playing 
time with a fully 
charged battery 

Playing time will be approximately 10 hours when 
playing the 44kHz, 128kbps mp3 files. 

Display Graphic LCD (128 X 64 dots) 
PC interface USB cable 
Maximum  
outside dimensions 

41.6 mm(W) X 90.5 mm (H) X 22.8 mm (D)  
(not including projecting parts and controls) 

Weight Approx. 52g without battery 
Accessories USB cable (1) 

Battery charger (1) 
Rechargeable battery (1) 
Installation CD-ROM (1) 
Stereo headphones (1 set) 
Carrying case (1) 

* Player specifications and external appearance are subject to change without 

notice. 
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2. Frequently asked questions 

 
� General questions 

 
What is MP3? 
MPEG-1 Audio Layer 3, one of most popular audio formats. It compresses 
standard audio tracks into much smaller sizes without significantly compromising 
sound quality. Since the MP3 file format has no mechanism for copyright 
protection, it is not widely used by commercial music data distribution sites. 
 
What is WMA? 
Windows Media Audio is an audio format developed by Microsoft Corporation in 
order to distribute CD-quality music even via low-speed communication lines 
such as ISDN. WMA employs a more efficient compression method than MP3, 
and has the advantage of reducing the bit rate with the least loss of sound quality 
(80 kbps encoding results in almost the same sound quality as MP3 encoded at 
128 kbps). 
WMA is a format suitable for portable players with limited memory. WMA also 
provides the mechanism that allows music files to contain encrypted data such as 
copyright-protection information in them in combination with Windows Media 
Rights Manager. 
 
What is the bps? 
Data flow per second denoted by “bps.”  Audio Manager allows you to select a bit 
rate of 160, 128, 96, 80, or 64 kbps for WMA format encoding and 320, 256, 192, 
160, 128, 96, 80, or 64 kbps for MP3 format encoding. 
 
What is a variable bit rate (VBR)? 
The variable bit rate (VBR) encoding method allocates fewer bits to silent 
sections or those with relatively narrow stereo separation, and allocates 
additional bits to sections that have relatively wide stereo separation. The 
constant bit rate encoding method uses a consistent bit rate throughout an 
encoded file. VBR allows smaller encoded file sizes without compromising sound 
quality. However, VBR is not recommended if you want the MP3 player to report 
accurate information about the duration of MP3 files, since it is difficult to predict 
MP3 file size. 
 
What is the CDDB? 
A database server that provides information about a music CD in your computer’s 
CD-ROM drive. CDDB-enabled encoding software will search the CDDB 
database on the Internet for information about your music CD, such as the album 
title, artist names, and track titles, and automatically enter the information to its 
track list. You do not have to manually enter information about your music CD. 
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� Questions about the EV-128MRS player 
 
How do I expand the memory? 
The EV-128MRS player incorporates 128MB of Flash Memory. You can add 
memory by installing a MultiMediaCard (8MB, 16MB, 32MB, 64MB). 
 
Can files on a MultiMediaCard that have been written to by an EV-128MRS 
player be played back on another portable player? 
No, they can not be played back on another portable player. 
 

How many minutes of music files can the EV-128MRS player hold? 
It depends on the amount of installed memory and the bit rate used for encoding. 
If you select “96 kBit/s, Near CD, 15:1 reduction” in the “Options” dialog box for 
encoding WMA, the 128MB internal Flash Memory allows you to store about 182 
minutes of music files. The time is reduced to about 136 minutes with the “128 
kBit/s, CD Quality, 11.25:1 reduction.” 
 
How long does the battery last? 
In case of playing 128kbps, 44.1kHz mp3 files, a fully charged battery gives you 
about 10 hours of playback time. 
 
 
The volume level differs among tracks. 
The volume level of the encoded music files depends on the music source and 
the software used for encoding.  
You need to adjust the volume level manually on the player, because the 
encoding software usually does not support a function to adjust volume level. 
 
Can I use the EV-128MRS player with a Macintosh computer? 
No, you cannot. The EV-128MRS player does not support Macintosh computers. 
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3. Troubleshooting 

 
If you encounter a problem while using the EV-128MRS player, try the remedial 
actions listed below. Should the problem persist, consult the store where you 
purchased the EV-128MRS player.  
 
The buttons are not functional. 
à  Check to see if the HOLD switch is set to the HOLD position. 
à  Check to see if the rechargeable battery is installed properly. 

Check if the + and - poles of the rechargeable battery are properly aligned. 
Check to see if the rechargeable battery needs recharging. 
Check to see if memory status is all right. 

à  Format the memory media using the format function of the supplied Audio 
Manager software. 
à  If the problem persists, remove the battery, then reinstall it to reset the player.   
 This often helps solve a problem. 
 
Nothing or unusual action on the display 
à  Check to see if the rechargeable battery needs recharging.  
à  Remove the battery, then reinstall it to reset the player. 
   This often helps solve a problem. 
 
 
Various troubles with playback 
• “NO FILE” is displayed on the EV-128MRS player. You may have failed to 
transfer music files to the EV-128MRS player. 

à  Check the USB cable connection and remaining battery power, and try to 
transfer music files to the EV-128MRS player again. 

• Some parts of a data stream may be damaged because of power fluctuations 
while transferring music files. 

à  Format the memory media using the format function of the supplied Audio 
Manager software. 

• The player cannot play tracks that are stored on the MultiMediaCard.  
à  Check that the MultiMediaCard has been inserted into the card slot 
properly. 
Push the MultiMediaCard into the card slot until it is locked, holding it with the 
beveled corner to the right. 
à  Check that you are not using a MultiMediaCard written to by another player.  
You can only play a MultiMediaCard on the EV-128MRS player that was used 
to transfer the music files. 
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The EV-128MRS player does not play tracks. 
• The EV-128MRS player supports WMA and MP3 files encoded with one of the 
following bit rates and sampling frequency. 

–WMA files encoded with a bit rate of 64, 80, 96, 128, or 160 kbps and a 
sampling frequency of 44.1 kHz  
–MP3 files encoded with a bit rate of 64, 80, 96, 128, 160, 192, 256, or 320 
kbps and a sampling frequency of 22 kHz to 48 kHz  
Files other than WMA- or MP3-format files may not be played back on the EV-
128MRS player even if they are transferred to the player. Even files in WMA 
or MP3 file format may not be played back, if they are encoded with a bit rate 
or sampling frequency outside the range supported by the EV-128MRS player.  
à  Retransfer the files after encoding them using WMA or MP3 file format with 
an appropriate bit rate and sampling frequency, if possible. 

• Some MP3 files that are encoded with VBR (variable bit rate) may not be played 
back on the EV-128MRS player.  

à  Retransfer the files after encoding them with a constant bit rate. 
 
With some files, the elapsed playing time indicated on the display is not 
accurate, and sound skip occurs. 
• Files encoded with a bit rate or sampling frequency outside the range supported 
by the EV-128MRS player may cause inaccuracy of elapsed playing time 
indicated on the display and sound skip. 

à  Retransfer the files after encoding them with an appropriate bit rate and 
sampling frequency. 
* This problem may still remain with some files even if they are encoded with 
an appropriate bit rate and sampling frequency. 
 

• MP3 files that are encoded with VBR (variable bit rate) also may cause 
inaccuracy of elapsed playing time indicated on the display and sound skip. 

à  Retransfer the files after encoding them with a constant bit rate.  
* This problem may still remain with some files even if they are encoded with 
a constant bit rate. 
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ONE HUNDRED EIGHTY DAYS  
LIMITED WARRANTY 

  
MPMAN warrants that its MPMAN product, and the component parts thereof, will be 
free from defects in workmanship or materials for one hundred eighty days from the date 
of purchase by the original user, on the terms stated herein.  
  
This warranty shall not apply to appearance or accessory items including but not limited 
to mechanical parts, cabinet, cabinet parts, knobs and etc.  
  
This warranty shall, in addition, not apply to damages due to handling, transportation, 
unpacking, set-up, incorrect charging and battery installation, customer adjustments that 
are covered in the owner's manual, loss of parts, repair or replacement of parts and any 
other accessories supplied by other than the MPMAN authorized dealer, any malfunction 
or failure caused by or resulting from abnormal environmental conditions, improper 
unauthorized service, improper maintenance, modifications or repair by the consumer, 
commercial use, rental use, abuse, misuse, abnormal use, neglect, accident, fire, flood, or 
other Acts of God. 
  
This warranty becomes void in the event serial numbers and bar code labels are altered, 
defaced or removed. 
  
Should this product become inoperative under the circumstances warranted within the 
warranty period, it will be repaired or replaced at our option without charge, provided it is 
returned in secure packaging at freight prepaid and sent to an authorized MPMAN dealer 
together with a duplicated copy of the original purchase dated and store-identified sales 
receipt. 
  
You must pay any initial shipping charge required to ship the product for warranty service 
by way of traceable carrier or first class mail to avoid loss in transit to MPMAN, but the 
return charges will be at our expense if the product is repaired or replaced under warranty.  
  
How to get prompt and efficient service? You must pack in a strong carton and pad tightly 
to avoid damage. Damage in transit is not covered by warranty.  If possible, use the 
original packing material.  On the carton, carefully print the name and address of 
MPMAN. Do not forget to include your return address.  Enclose this completed 
warranty registration form. Indicate as clearly as possible, the nature of defect. A 
defective product will not be repaired or replaced unless this warranty registration form 
and a duplicated copy of sales receipt accompanies the product at the time of shipment for 
repair or replacement. 
This warranty is the purchaser's sole and exclusive warranty and is in lieu of all other 
warranties, including any warranty of merchantability or fitness for a particular purpose.  
There are no other warranties or conditions, expressed or implied, statutory or otherwise.  
MPMAN neither assumes nor authorizes any person to assume for it any other obligation 
or liability in connection with the sale or service of the product. 
  
MPMAN's obligation under this warranty shall be limited to the repair, including all 
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necessary parts and the cost of the labour connected therewith, or at our option, the 
exchange of the product. 
In no event, shall MPMAN's liability exceed the purchase price paid by the purchaser for 
the product. 
Replacement parts, furnished in connection with this warranty shall be warranted for a 
period equal to the unexpired portion of original product warranty.  
   
The repair or replacement, at MPMAN's option, shall constitute purchaser's sole and 
exclusive remedy and MPMAN's only liability to the purchaser.  MPMAN reserves the 
right to replace any discontinued product with one of equal value.  
Except for the obligations specifically set forth in this warranty statement. In no event, 
shall MPMAN be liable for any special, exemplary, direct, indirect, incidental, or 
consequential damages under any circumstances and any delay in the performance of this 
warranty due to cause beyond our control, whether such liability is based on contract, tort, 
strict liability, and any other legal theory or otherwise. 
  
The purchaser may have other rights under existing state(provincial) or federal laws and 
where any terms of this warranty are prohibited by such laws on how long an implied 
warranty lasts and/or exclusion or limitation of incidental or consequential damages; the 
above limitations may not apply to you but the remainder of this warranty shall remain in 
effect. 
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WARRANTY REGISTRATION FORM 
------------------------------------------------------------------------------------------------------------ 

 

Owner's name and address: 

First name: ______________ Initial: _________ Last Name: _______________ 

Address: street __________ Apt.No.: #_________ City: ___________________ 

State (Province): ________ Country:_____ ______ Zip code: _______________ 

Phone Number: _________________ E-mail address: ____________________ 

  

Dealer(store)'s name and address(where purchased): ____________________  

_________________________________________________________________  

 

Purchase date: ______________ Expiry date: ___________________________  

Product name: _________________ Model No.: __________________________   

Serial No. __________________ Nature of defect: ________________________   

_________________________________________________________________  

_________________________________________________________________  

_________________________________________________________________  

(For official use) 

Repaired (Replaced) at: _____________________________________________  

Date: ____________________________________________________________  
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㈜엠피맨닷컴 
 

■서비스센터 / 고객상담실  
클로바전화 :  080-567-3131 / 080-466-7626 
 
■인터넷 홈페이지  
http://www.nowevolution.com 
 
■본사주소 

(우)135-798 서울시 강남구 삼성동 159-1 아셈타워 2층 
 
 

 
 
P/N : 390-710015-010 

 


